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Window Menu

Cascade
Tile Horizontally
Tile Vertically
Arrange Icons



File Menu

New ...
Open ...
Close
Save
Save As ...
Save All
Printer Setup ...
Print ...



New

Creates a new COMponent window as one of the following types:

DATACOMponent Window

If you are running in Advanced User mode, you may open as many windows as you would like.    Keep in 
mind that each DATACOMponent Window, however, must be connected to a unique line.



Open

Opens an existing DATACOMponent document window:

All of the settings stored in the file will be used when the line is opened.



Close

Closes the active document window.

Although several documents may be open at once, this command closes only the active document (you 
make a document active by clicking on its title bar.)



Save

Saves the active document to the directory and filename associated with it when the file was opened.

Although several documents may be open at once, this command closes only the active document (you 
make a document active by clicking on its title bar.)



Save As

Saves the active document to a different directory and/or filename than it was associated with when it was
opened.

Although several documents may be open at once, this command closes only the active document (you 
make a document active by clicking on its title bar.)



Save All

Saves all open documents at once.



Printer Setup

Opens the Print Setup dialog box which allows you to change the printer you wish to print to or the print 
characteristics of your current printer before you print a document.

Print characteristics are things like print quality, paper type, media size, etc.



Print

This opens the Print dialog box which allows you to print documents on your printer.

You can select the range of pages to be printed and access the setup dialog for your printer.



Help Menu

Index
Using Help

About DATACOMponent



About DATACOMponent

Display system, version and distribution information about the DATACOMponent.



Tools Menu
This is a customizable menu which allows you to add your own tools and show or hide toolbars
in FAX32COMponent.

When you add tools to the menu, they will appear as menu commands below the Toolbars and Customize
commands.

Toolbars ... - Show or hide FAX32COMponent toolbars.
Customize ... - Add or remove commands to the Tools menu.



Toolbars

This dialog allows you to turn COMponent toolbars on or off.

With this function, you can arrange toolbars anywhere on the COMponent display.

The Toolbars listbox shows all of the available tool bars.    To change the tool bar status:

1) Select the toolbar you want from the list.
2) Click on [SHOW] to make the toolbar visible or [HIDE] to remove the toolbar from the
display.

If you turn on Tool Tips, a brief description of each tool is shown when you leave the mouse cursor over 
its icon for one second.



Customize

In Tools Menu Customization, you add new commands to the Tools menu.

A tool is a program or command external to COMponents, which you may want to use while in 
COMponents.    You may customize the Tools menu using this dialog to add any programs you like.

The customize dialog includes the following areas:

Menu Items:

Listbox - Contains a list of your added tools.

New - Add a new tool.
Remove - Delete the selected tool.
Move Up - Moves the list up.
Move Down - Moves the list down.

Tabs:

General - Basic information for the added tool. 
Window - Defines the size and position, etc. for the tool window. 
Console - Defines a color scheme for the tool window. 
Options - Other items that define the behavior of the tool. 



Options Menu
Location ...
Workspace ...
Language ...
Line/Modem Setup...



Location
This dialog allows you to change settings specific to your current physical location.    These 

settings are used when sending faxes or calling other modems to build the proper dialiable phone number
and for text substitution on the cover pages and headers.

See Also:    Location Tab



Workspace
You may customize the look and feel of the applications windows from this dialog.    In addition to 

changing the background color and displaying bitmaps on the background you may also choose the user-
mode, Novice or Advanced.

See Also:    Workspace Tab



Language
Use this dialog to switch the language the user-interface is currently using.    If you have more 

than one language intstalled, you will be presented with all available languages in a list.    When you 
change the language, the user-interface will instantly change to the new language.    No rebooting or 
restarting the software is necessary.

See Also:    Language



Line/Modem Setup
If you wish to add, remove, or modify lines/modems from COMponents this is the correct option to

select.    This dialog allows you to auto-detect and Add newly installed modems as well as edit the 
configuration of exsitsing modems.

See Also:    Line/Modem Setup Dialog



Terminal Menu
Dial...
Hang Up
Answer Now
Capture to File/Printer
Create / Edit Phonebooks ...
Access Phonebooks ...
Access Logs ...
Settings ...



Dial...

Invokes the dialing dialog to allow you to dial remote locations.

See Also:    Dial Dialog



Hang Up

This option is available when you are on line only.    It causes the connection to be immediately terminated
and the phone line is hung up.



Answer Now

Forces the DATACOMponent to immediately answer the phone and try to connect as a data connection.



Capture to File/Printer

Enables and disabled the Capture mode.    You may capture incoming text to either a file, a printer, or 
both.

See Also:    Capture to File/Printer Dialog



Create/Edit PhoneBooks

This dialog is used to create and maintain phone lists; it consists of three sections:

Phone Lists Window - shows existing phone lists you previously created and allows you to 
delete and reorder them and create new ones.

Fields Tab - for changing the structure of a phonelist database.

Options Tab - for changing the way a phonelist is displayed.



Access Phonebooks

This dialog is for maintenance of records within the phone lists you have created.    Use this dialog to add 
or edit new records and groups.



Settings

This tabbed dialog allows you to modify settings related to terminal operations.

There are 7 tabs in this dialog:

Emulator - Select and configure the terminal emulator.
Connection - Configure the COM port settings.
Transfer - Select and configure transfer protocols.
Buffer - Configure options related to file capture and scroll back buffer operation.
Color - Configure the terminal screen colors.
Cursor - Customize the terminal window cusor.
General - Configure general terminal options.



Terminal Setting - Emulator Tab

Use this tab to configure settings related to the current terminal emulator.    You may independantly 
specify the number of rows and columns that define the screen.    Options are also provided for modifying 
the input and output of characters through the emulator.

If you would like to see characters displayed in the terminal window when you are typing on line or if you 
are seeing “double” characters try changing the state of the Half Duplex check box.



Terminal Settings - Connection Tab

Use this tab to configure the terminal settings related to the COM port.    For transfering files we highly 
recommend that Hardware flow control is enabled.

You may also modify settings for the modem the Terminal windows is currently connected to by selecting 
the [Configure...] button.

See Also:    Configure Line/Modem



Terminal Settings - Transfer Tab

Use this tab to define settings for file transfers.    The protocols that you select here will be used as 
defaults when you initiate a transfer.    You may change them at the time you begin the upload or 
download, however.

You may also specify the MailBox where transfers should be logged and the directories for the InBox and 
OutBox.



Terminal Settings - Buffer Tab

Use this tab to configure how the scrollback buffer should be handled.    You can choose to have the 
buffer saved from session to session.

You can choose to be prompted for the specifics of the capture at the time you are invoking it or specify 
all the details here, or both.    For complete information on Capture Options see Capture Options Dialog.



Terminal Settings - Color Tab

Use this tab to pick you screen colors.    You may also choose between three different color filters.

See Also:    Color Filter



Terminal Settings - Cursor Tab

Use this tab to specify custom shapes or bitmaps for the Terminal’s cursor.



Terminal Settings - General Tab

Auto-save terminal settings will suppress the Save As dialog when you are closing down a terminal 
window that has changed.    The settings for the terminal window will be saved automatically under the 
same name as it was opened.    If the window is a new window, you will still be prompted to provide a 
name for the new terminal document.

You can also toggle the display of the terminal status bar.



Access Logs

Use the logs to view information about previously sent or received FAX documents.    This is a convient 
dialog to access when you want to view, print, or re-send any sent or received fax file documents.    You 
can also view detailed information about each particular fax job, including the type of error that occurred if
any.

See Also:    MailBox/Log Access



Data InBox/OutBox Details

Use this dialog to view the details of a file upload or download.

The dialog contains job specific details.    By clicking the [Error Help...] button, you will be taken to a 
precise explanation of the error and some potential solutions.



Dial Dialog

Use the dialing pad or the edit field to enter the precise number you wish to dial.

The Dialing Options group allows you to modify the number of retries and the delay between retries.    You
may also access any of your phonebooks from within this dialog.    Click the [Phone Lists...] button to 
drop down the phone lists.    Selecting an entry in the phone list will cause the Number edit field to be filled
with the phone number.

You may use the dial to “queue” numbers to be dialed.    You can either select a group from the phone list 
or indivially pick multiple phone numbers.    The numbers will be dialed in a “round-robin” fashion until a 
connection is established with one of them.    All other numbers are ignored once one destination is 
successfully connected to.



Capture To File/Printer

This dialog allows you configure how incoming text will be captured.

It consists of three areas:

Capture To Device
Use this section to specify whether you wish to capture incoming text to a disk file, a 
printer, or both.

File Options
These options apply only if capture to file is enabled.    If the file exists the overwrite 
option will cause all existing data to be overwritten.    Otherwise, it will be appended to the
end of the file. 

Capture Mode
Standard Text is captured line by line as it appears on the screen. 
Binary All incoming data is captured, including terminal escape sequences. 
Visible Useful for capturing data a screen at a time when the current emulator is 

ANSI. 



View Menu

Scale Rows To Fit
Color Filter
StatusBar



Scale Rows To Fit

If the currently selected terminal font is a True Type font, this option is available.    When this option is 
turned on, the font will shrink or grow as necessary to keep the specified number of rows on the screen at
all times.



Color Filter

This option is useful for users who do not have color screens and who are using the ANSI terminal 
emulation.    The ANSI colors are “mapped” to appropriate grayscale or black and white to achive the best 
possible representation.

Full Color
Grayscale
Black & White



Full Color

Displays all appropriate colors depending upon the current terminal emulation.



Grayscale

For people with grayscale monitors, this is the best choice for trying to view ANSI screens when in ANSI 
emulation mode.



Black & White

For people with black & white monitors, this is the best choice for trying to view ANSI screens when in 
ANSI emulation mode.



StatusBar

Select this option to toggle the status bar attached to the bottom of the terminal window on and off.    The 
status bar provides a convienient mechanism to change settings related to the terminal window.    Simple 
click on the appropriate pane and pick the desired option from the pop-up menu.



Transfer Menu

Upload
Download
Abort Transfer



Upload File

This option is available only when the active terminal window is On-Line with another system.    Use this 
option to initiate sending one or more files to the remote system.

See Also:    Upload File Dialog



Download File

This option is available only when the active terminal window is On-Line with another system.    Use this 
option to initiate receiving one or more files to the remote system.

See Also:    Download File Dialog



Abort Transfer

This option is available only when in the process of uploading or downloading files.    Selecting it will 
cause the file transfer operation to be terminated.    You will still be left on-line with the remote system.



Upload/Download File Dialog

This dialog is used for both file uploads and file downloads.    Select the path and file(s) you wish to 
upload or download and choose the desired file transfer protocol.    Select OK to initiate the upload or 
download.    If the protocol supports batch uploads you will be allowed to select multiple files.

The path will default to the path that you have setup in Terminal Settings for uploads and download.

Note:    Some file transfer protocols allow for “batch” or uploading of multiple files at a single time.    Other 
protocols can only transfer a single file at a time.



DATACOMponent Basics
The DATACOMponent can be accessed by running it as a stand-alone program (V3DATMCP.EXE) or 
from within the COMponent Workspace.    If run from within the COMponent Workspace the user mode 
(Novice vs. Advanced) effects the options available to you when you have a terminal window displayed.

There are a few major differences when the DATACOMponent is run in Novice vs. Advanced mode.    In 
Novice mode you are only allowed to have one DATACOMponent Window up at any one time.    This 
means only one modem will be able to be used at any one time.    In Advanced you may have as terminal 
windows displayed as you have modems connected to your computer.

A DATACOMponent Terminal Window file (.TML) is the document that provides access to your modem 
and its settings.    There is a one to one relationship between DATACOMponent Windows and installed 
modems.    In order to dial other computer and to send and receive files you must create or open a 
DATACOMponent Window for each modem you have installed.    You can create a new DATACOMponent 
Window by selecting “New..” from the “File” menu.    If you have more than one modem installed, you will 
be prompted to select which modem you want to associate with the terminal window.    Once the modem 
has been associated with the window, you are ready connect to other computers.

To learn more about some of the common procedures see the following sections:
How To Send A File, How To Receive A File



DATACOMponent Environment

The DATACOMponent application is another module in the suite of COMponent modules.

It can be run as a stand-alone application, but it also is automatically integrated into the COMponent 
Workspace.    All of the functionality provided by the DATACOMponent is available no matter how it is run 
or where it is accessed from.

The DATACOMponent, like other COMponent modules allows you to create any number of windows 
within its workspace.    This capability is called the “Multiple Document Interface” and is a standard user-
interface model which is used in many other Windows applications and should be famailiar to the 
Windows user with only a small amount of experience.

The “Multiple Document Interface” (MDI) is a powerful user interface model that allows you to open more 
than one document, in this case, fax file, cover page or header, simultaneously.    This makes it easy to 
switch between different files quickly and allows for quick transfer of data from one document to another.

There is only one type of document that the DATACOMponent can create or edit:

DATACOMponent Terminal (.TML)
A DATACOMponent window can be created for each modem you have installed in your 
system.    All of the terminal related settings for each modem are stored in the TML file.    This 
capability allows you to store different settings in different TML files and Open them at a later 
time without having to recreate special settings.    The DATACOMponent window consists of a
single view, the terminal window itself:

The DATACOMponent is automatically configured to “remember” the position and information contained 
in the TML documents you have open when you close it down.    Moreover, when you restart the 
application, the previously opened documents will be automatically re-opened for you and any 
DATACOMponent Terminal Windows you had open will attempt to open a connection to your modem.    
You can turn this capability off in the Workspace dialog from the Options menu.

As with the other COMponent modules, the DATACOMponent contains a Tools menu and an Options 
menu that are always available.    The Tools menu, among other things, provides access to showing and 
hiding toolbars.    The Options menu can be used to alter settings related to the DATACOMponent itself, 
such as the Workspace settings described above.



DATACOMponent Troubleshooting
Problem:

Uploads seem to keep resending and starting over.

Solution:
Make sure hardware flow control is turned on through Terminal Settings.

Problem:
Modem fails to connect to remote system after dialing.

Solution:
Try lowering the baud rate from the Terminal Settings dialog.

Problem:
Zmodem downloads don’t start automatically.

Solution:
Make sure the Auto download option is checked on the the Transfer Tab of the Terminal Settings 
dialog.



Dockable Phone Bar

This is a hideable tabbed window that can be placed anywhere in the FAX32COMponent window.

The dockable phone bar presents a card-file-like view of the phone lists you have created and allows you 
to modify phone list properties and individual records within the phone list database.

The phone bar’s layout consists of:

· Tabs representing your phone lists.

· A window area below the tabs, which displays a list of records in the currently selected phone 
list.

· A button bar on the left, which allow you to access the tools necessary to maintain the selected
phone list.    These tools include:

Add Phone List Entry
Edit Phone List Entry
Delete Phone List Entry
Find Phone List Entry
Access phone list Notes
Access phone list Properties

NOTE:    clicking the Right Mouse button while the mouse cursor is inside the phone list’s window 
will bring up a menu of these tools.

The dockable phone bar serves as a quick way to access your phone lists and the information contained 
within them.

See Also:

Create/Edit Phonebooks
Access Phonebooks



Add Phonelist Entry - Data Tab
This tab contains all of the specific information you can define for the record, related to data calls.

The areas on this tab are:

· Dial Options 

- Allows you to modify the manner in which the data number is dialed.
See Dial Options for more infomation.

· Emulation

- This section allows you to which terminal emulator to use for the call.

· Connection

- Use this section to specify the COM port settings for the current number.



Dial Options
You can override the default dialing options for any records by changing the options in this dialog.    The 
number that will be dialed is displayed at the top of the dialog.

There are three different categories of options that may be modified:

International Options -- Checking this option causes the international access number (011 for the United
States) to be dialed if the number is an international call.    This option is checked on by default.

Long Distance Options -- Checking this option causes the long distance access number (normally 1 for 
the United States) to be dialed if the number is a long distance call.    This option is checked on 
by default.

Local Options
Dial as Long Distance (Local Toll) -- Checking this option causes a local number to be dialed as 

though it were a long distance number. The Long Distance Options are observed when dialing 
as a local toll.    This option is checked off by default.

Omit First Digit of Phone Number -- Checking this option causes the first digit of the phone number 
to not be dialed.    In some countries when dialing a local call, the first digit is not required.    This 
option is checked off by default.



How To Send A File

Sending a file using the DATACOMponent is actually a very simple process.    There are only two things 
you need to know:    1.    What file do I want to send? and 2.    Where do I want to send it?

Before you can transmit or receive any files you must make a data connection with the computer that you 
wish to exchange files with.    You may do this by dialing the number using the Dial command from the 
Terminal Menu.    Note that you may also add phone numbers of frequently accessed computers to the 
Phone List.

Once you have dialed and the modem has successfully connected, you will see a message on the screen
that should look something like this:    CONNECT 14400, etc.    At this point you are On-Line with the 
remote system and can type information in the terminal window.

When you are ready to send or receive a file, simply choose Upload or Download file from the Transfer 
Menu.    You will be prompted with a dialog to select the files and or path that you wish to use for the 
transfer.    When you click OK in this dialog, the transfer will begin.



How To Receive A File
Before you can transmit or receive any files you must make a data connection with the computer that you 
wish to exchange files with.    You may do this by dialing the number using the Dial command from the 
Terminal Menu.    Note that you may also add phone numbers of frequently accessed computers to the 
Phone List.

Once you have dialed and the modem has successfully connected, you will see a message on the screen
that should look something like this:    CONNECT 14400, etc.    At this point you are On-Line with the 
remote system and can type information in the terminal window.    Note that another computer can also 
dial yours.    When you have the DATACOMponent window displayed it will answer the incoming call and 
try to connect.

When you are ready to send or receive a file, simply choose Upload or Download file from the Transfer 
Menu.    You will be prompted with a dialog to select the files and or path that you wish to use for the 
transfer.    When you click OK in this dialog, the transfer will begin.



Edit Menu
Copy
Copy Special
Paste
Paste Special
Clear Window
Clear Scrollback



Copy

Copy is used to copy the current text selection to the windows clipboard.    Select text in the terminal 
windows by holding down the LEFT mouse button and dragging over the lines of text you wish to copy.    
Once copied tou can then paste the text from the clipboard to another document or another location within
the current terminal window using the PASTE command.

See Also: CopySpecial, Paste, Paste Special, Clear Window,and Clear Scrollback



Copy Special

There are two types of special copy operations:

Window Contents
Scrollback Contents

See Also: Copy, Paste, Paste Special, Clear Window, and Clear Scrollback



Copy Special - Window Contents

Copies the contents of the visible terminal window to the Window’s Clipboard.    You can then paste the 
clipboard contents into other documents.

See Also: Scrollback Contents, Copy, Paste, Paste Special, Clear Window,and Clear Scrollback



Copy Special - Scrollback Contents

Copies the contents of the entire scrollback buffer to the Window’s Clipboard.    You can then paste the 
clipboard contents into other documents.

See Also: Window Contents, Copy, Paste, Paste Special, Clear Window, and Clear Scrollback



Paste

Paste is used to copy the contents of the clipboard into the current document.

When you choose this command, the clipboard contents are copied into the upper left hand corner of the 
current document.    The copied object is automatically selected and can be moved anywhere in the 
document using the mouse.

See Also: Copy, CopySpecial, Paste Special, Clear Window, and Clear Scrollback



Paste Special

There are three types of special paste commands:

Paste To Host
Paste Text File
Paste Binary File

See Also: Copy, CopySpecial, Paste, Clear Window, and Clear Scrollback



Paste Special - Paste To Host

This command will paste the contents of the windows clipboard directly out the modem to the remote host
computer.

See Also: Copy, CopySpecial, Paste, Clear Window, and Clear Scrollback



Paste Special - Paste Text File

This option allows you to select an entire text file to paste.

See Also: Copy, CopySpecial, Paste, Clear Window, and Clear Scrollback



Paste Special - Paste Binary File

This option allows you to select any binary file to paste.

See Also: Copy, CopySpecial, Paste, Clear Window, and Clear Scrollback



Clear Window

Permanently deletes the contents of the current terminal window.

NOTE:
      Be careful with this command, because the text visible in the terminal window will be permanently 
deleted from the scroll back buffer.

See Also: Copy, CopySpecial, Paste, Paste Special,and Clear Scrollback



Clear Scrollback

Permanently deletes the entire contents of the scrollback buffer.

NOTE:
      Be careful with this command, because all    text will be permanently deleted from the scroll back 
buffer.

See Also: Copy, CopySpecial, Paste, Paste Special, Clear Window, and Clear Scrollback



DATA Error Codes

200 -- User cancelled.
201 -- Maximum retry count exceeded.
202 -- File open failed.
203 -- File seek failed.
204 -- Carrier dropped during transfer.
205 -- Out of disk space.
206 -- Send aborted.
207 -- Sender cancelled.
208 -- Unknown transfer termination.
209 -- Unexpected reply from receiver.



Error 200:    User Cancelled

Problem:
The transfer operation was cancelled before it was completed.

Solution:
Re-transfer the document(s)



Error 201:    Maximum Retry Count Exceeded

Problem:
Attempted to establish a protocol link, but failed..

Solution:
Re-transfer the document(s)



Error 202:    File Open Failed

Problem:
Unable to open or create a file during the transfer operation.

Solution:
Check for available disk space.    Re-transfer the document(s)



Error 203:    File Seek Failed

Problem:
Unable to properly access one of the files during the transfer operation.

Solution:
Check your hard-drive for disk space and errors.    Re-transfer the document(s)



Error 204:    Carrier Dropped During Transfer

Problem:
The connection was lost during the transfer operation.

Solution:
Re-connect and re-transfer the document(s)



Error 205:    Out Of Disk Space

Problem:
No more space is available on your hard drive.

Solution:
Free up some disk space and re-transfer the document(s)



Error 206:    Sender Aborted

Problem:
The remote machine aborted the transfer operation.

Solution:
Re-transfer the document(s)



Error 207:    Sender Cancelled

Problem:
The remote machine cancelled the transfer operation.

Solution:
Re-transfer the document(s)



Error 208:    Unknown Transfer Termination

Problem:
The transfer was terminated for an unknown reason.

Solution:
Re-transfer the document(s)



Error 209:    Unexpected Reply From Receiver

Problem:
An error occurred in the transfer protocol.

Solution:
Re-transfer the document(s)




